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ongratulations on purchasing your Virtual CD Server  from Academy Computer Services, Inc. This
system takes up a small amount of space, but replaces millions of pages of text. Gigabytes of
information are less than a second away. Your new server system features:

•  High Speed CD–ROM drive drives fully compatible with ISO 9660.
•  StorPoint CPU with 10/100Base-T Ethernet connection for fast network access.
•  Large RAM cache and powerful Bay PC processor.
•  Up to 250 users.
•  Tower enclosure with ample power for all drives and cooling fans for long drive life.

WARNING: Changes or modifications to this unit not expressly approved by the party responsible
for compliance could void the user’s authority to operate the equipment.

NOTE: This equipment has been tested and found to comply with the limits for a Class A digital
device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable
protection against harmful interference when the equipment is operated in a commercial
environment. This equipment generates, uses, and can radiate radio frequency energy and, if not
installed and used in accordance with the instruction manual, may cause harmful interference to
radio communications. Operation of this equipment in a residential area is likely to cause harmful
interference in which case the user will be required to correct the interference at his own expense.

This manual explains how to install your new Virtual CD Server . You will need to:

1. Unpack and check the shipment.

2. Connect the unit to the network.

3. Image CDs for network access.

4. Make imaged discs available to research software.

C

Copyright  © 2000 by Academy Computer Services, Inc.. All rights reserved. No part of this work
may be reproduced or transmitted in any form or by any means, electronic or mechanical, including
photocopying, recording, or by any information storage or retrieval system, without the prior written
permission of the copyright owner.
Call 800-38-Logic for help
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Unpacking the Virtual CD Server
Carefully unpack your shipping box:

WARNING: Server units can weigh as much as 30 pounds and should be lifted by two individuals.
Observe the practice of bending the knees, not the back. Be certain both people have a firm grasp on
the unit itself, not just the plastic wrap or other packing materials. Such materials will slide over the
component and could cause the unit to drop. Dropping the tower will result in equipment damage
and possible personal injury.

Check to see that the shipment is complete.

Virtual CD Server
Large box:
Virtual CD Server
Accessory Bag:
Black Power Cord
SCSI Terminator
Category 5 Ethernet Patch Cable w/ RJ45
      connector
Axis StorPoint User's Guide
     w/ Axis Online CD
This Installation Guide

Figure 1, Package Contents

Place your server on a sturdy, flat surface. Academy recommends placement off the floor away from possible
dust contamination. If your package is incomplete or irregular in any way, please contact Academy without
delay at 800–385–6442.

System Prerequisites
You will need the following network components:

•  Windows 3x/95/98/NT , Novell NetWare , UNIX , or Macintosh  network using 10/100Base-TX
•  TCP/IP enabled on the workstation that will administer the Virtual CD Server .
•  An Internet web browser loaded on the administration workstation.
•  Ethernet patch cable to attach the Virtual CD Server  to the network.

WARNING: Before working with your computer or tower, unplug all units from their power
receptacles. Failure to do so will result in personal or equipment injury. Also, to avoid static shock
damage to either tower or computer, touch a bare metal portion of that system’s chassis before
touching any electronic component. Failure to do so could damage the equipment.
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Connecting to the Network

Physical Connection
1. Insert the Category 5 Ethernet patch cable into the RJ-45 connector at the rear of the Virtual CD

Server . Insert the other end into a network hub.
2. Connect the power cable to the Virtual CD Server  and plug it into the power strip or outlet. Use of

a surge protector is strongly recommended for long system life.
3. Turn on the Virtual CD Server .

Assign the IP Address
The Virtual CD Server  must be assigned a valid IP Address. There are two different methods to perform
this task: Dynamic and WinPoint. Both methods are detailed below. Select the method that is best for your
network needs and follow the instructions.

Dynamic
The Virtual CD Server  will dynamically acquire an IP address if your network currently uses DHCP,
BOOTP or RARP. No further action is needed.

WinPoint
WinPoint is a program created by Axis to assign

Install the WinPoint Program
1. Insert the Axis Online CD

2. There is an Autorun feature on the CD. If this launches, select the Software link. Then select the Axis
WinPoint to start the setup process.

3. If the Autorun feature does not launch, open My Computer or the Windows Explorer and browse to the
CD. Double-click on the Index.html file. Select the Software link. Select the Axis WinPoint link. Click on
the Software Button in the Install software section

4. Follow the steps of the Setup Wizard

4.1. Close the Installation program when complete.

Set the IP Address
1. If the SetupWizard has created a desktop icon, click on the icon to begin the program. As WinPoint

starts, the network is browsed, and all Virtual CD Servers are displayed in the window.

1.1. If no Virtual CD Servers display in the window select WinPoint Settings from the File menu.

1.2. Use the radio buttons in the "Network Protocol to locate servers with" section to narrow the
search area.

1.3. Click on Apply. Click on OK.

1.4. Select the View menu and the Refresh option.

2. Highlight the Virtual CD Server Icon

3. Select the File menu.



PAGE 6 VIRTUAL CD SERVER  8I ADMINISTRATION GUIDE

Call 800-38-Logic for help

4. Select the Set Internet Address option. Enter the correct IP Address. Enter the Router address if one is
in use. Enter the Subnet Mask.

5. Click on the Submit button.

6. Restart the Virtual CD Server.

Administration
After the IP address has been set, the Virtual CD Server may be administered via a web browser.

1. Open the workstation web browser. Enter the Name of the Virtual CD Server  in the browser’s address
field. For example http://xxx.xxx.xxx.xxx or http://192.168.1.104. The user View File page will open.

2. Click on the Admin button to access the Administrator pages.

2.1. The default user and password is root and pass.

3. The This StorPoint page will open. This page links to all other Administration pages. On this page the
SCSI devices, and general hardware and software information is listed

This StorPoint
This page displays information about the Virtual CD Server 8i. Caching options are set by clicking on the
Settings button.

Settings
A new browser window will open when the Settings button is selected. There are four tab selections in this
window: General, Date & Time, SCSI, and Caching & Archiving.

General
Create new a Server password

Date & Time
Use the drop down list to edit the Time Zone.

Time can be acquired through two methods: Automatically and Manually. Use the radio buttons to select a
method. If Automatic NTP time is chosen, enter the NTP server in the box provided.

SCSI
The SCSI bus mode can be modified on this page.

Caching & Archiving
Caching is the process of copying CD-ROM data to a hard drive. There are three caching modes: Partial,
Mirror, and Archive.

Only Archived CDs are available after the physical CD has been ejected. Partial and Mirror caches
require that the physical CD-ROM remain in the drive bay.

A Partial cache will copy the directory structure of the CD-ROM onto the hard drive. This permits faster
browsing of the CD-ROM. The size of the cache file can be entered using the drop down list.
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A Mirror cache copies all of the CD-ROM data to the hard drive. This permits faster user access of the data,
as hard drives respond faster that CD-ROMs. The Mirror process is executed in the background. If a user
attempts to access a disc during the cache process, the response will be from the physical CD-ROM.

If a Mirror cache has been requested, but there is not enough space on the hard drive to store all the data, the
system will default to a Partial cache.

Archive caching is established through the Disc & Drives web page.

Disc & Drives
The CD-ROM and Cached CD contents of the Virtual CD Server 8i are managed from this page. There are
two methods of viewing this information: Discs and File System, and Drives.

Access Control
The Discs and File System selection displays a directory tree structure. Network share access control can
be managed from this view. Access rights to the network share, or the volume, can be modified on this page.
In addition, the Eject, Description, and Archive functions for the volume can be modified on this page.

The Drives selection displays each physical CD-ROM drive bay.  The drive number is assigned using the
SCSI bus number, and the SCSI ID number. Devices on the first bus begin with the letter A. Devices on the
second bus begin with the letter B. Access rights to both physical drive bays and the volume (CD-ROM)
inserted into the drive can be modified on this page. In addition, Eject, Description, Auto-Archive, Sorting,
and Lock functions can be modified on this page.

When access rights are assigned to a drive, any CD-ROM volume inserted into the drive bay will inherit those
rights. In addition, the CD-ROM will be shared on the network using the drive bay name, not the volume
name of the CD-ROM.

Auto Archiving
This option is instituted in the Drives view. When a check is placed in the Auto Archiving box, any disc
placed into that drive bay is automatically copied to hard drive. If the physical CD-ROM is removed the
Archived CD is still available to the network.

Deleting an Archived CD
1. Open the Discs and file system view.

2. Remove the check in the Archive box of the disc to be deleted.

Locking the Drive Bay
Locking the drive bay will disable the eject button on the front of the physical drive bay. However, the drive
may still be ejected from the Drive or Discs and file system pages. A CD-ROM can be ejected even it is in
use.

1. Open the Drives view.

2. Place a check in the Lock box of the drive bay to be locked.

3. All drive bays can be locked by clicking on the Lock All button.
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Network Settings
This page allows the Virtual CD Server 8i to be configured for a specific network environment. Please see the
section of this guide titled "Configuration Options" for more information.

The Wizard will ask a series of questions and use the for input to modify the network protocols.

The Detailed View allows for manual editing of protocol information.

Event Log
The Event Log lists system events and errors.

Statistics
This page details the current system configuration and network usage.

Support
This page has a series of links for standard technical support questions and answers

Help Contents
This page has a series of links to standard administration questions and answers.
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Configuration Options

NetWare Networks (NCP)
The Virtual CD Server 8i can function in three modes.

! Bindery without authentication

! Bindery with authentication

! NDS

Bindery without Authentication
No configuration modifications are needed to access the Virtual CD Server 8i in this mode. The unit
emulates a Novell 3x bindery server on the network. Client access is achieved by browsing Network
Neighborhood and mapping to the Volumes volume. By default all users will be able to access all physical or
Archived CDs.

Bindery with Authenticaiton
In this mode user names are authenticated by an existing Novell bindery server. The bindery server that is
providing authentication must be designated.

1. Open the Network Settings page.

2. Click on Wizard.

3. Select NetWare (NCP)

3.1. Click on Start.

4. Specify how the Virtual CD Server 8i should appear in the network.

4.1. The default name is AXISxxxxxx_NW. To accept this default click on Next.

5. Place a check in the box to select Bindery authentication.

6. Enter the name of the bindery server that will provide authentication in the box.

7. Click on Finish.

NDS
1. Synchronize the NDS tree.

2. Open Network Settings page.

3. Click on Wizard.

4. Select NetWare (NCP)
4.1. Click on Start

5. Enter server name (AXISxxxxxx_NW)

6. Select NDS or both NDS and Bindery

7. Select the NDS tree
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8. Select the context

9. Enter distinguished user name and password

10. Click on Close when done.

11. To confirm the NDS integration process, check the Virtual CD Server 8i event log for errors.

Windows Networks (SMB)
The Virtual CD Server 8i can function in two modes.

! User Level

! Share Level

1. Open the Network Settings page

2. Select Windows (SMB)

2.1. Click on Start

3. Enter Server name and Workgroup/domain name

4. Select User Level or Share Level access control

4.1. User level means that the Virtual CD Server 8i passes all user login requests to a PDC or BDC.
Only the Administrator user is locally authenticated. The name of the authentication domain
controller must be entered on the box provided, or all access requests will be denied.

4.2. Share Level means that a password is assigned to each shared resource of the Virtual CD Server
8i. User requesting access will be required to enter the password.

5. Click on Finish

Unix Networks (NFS)
No configuration modifications are needed to access the Virtual CD Server 8i in a Unix environment. If
changes are preferred the following steps will open the modification page.

1. Open the Network Settings page.

2. Click on Detailed View.

3. Select the Unix (NFS) tab.

3.1. Enable the protocol by placing a check in the provided box.

3.2. Enter the default user ID.

3.3. Enter the Authentication server address

3.4. Enable the exporting of the root of volumes by placing a check in the provided box.

4. Click on the OK button when done.
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Intranets (HTTP)
No configuration modifications are needed to access via a web browser. All CDs and the Administration
page can be accessed by all usersIf changes are preferred the following steps will open the modification page.

1. Open the Network Settings page.

2. Click on Wizard.

3. Select Web (HTTP).

4. Click on Start.
5. To allow CDs and Archived CDs to be accessed through browsers place a check in the box.

5.1. To remove all user access to the Administration web page place a check in the box.

6. Click on Finish.

Mac Networks (AFP)
1. Open the Network Settings page.

2. Click on Wizard.

3. Select Macintosh (AFP).
3.1. Click on Start.

4. If desired, modify the server name an Zone it will appear in.

5. Select the protocol the Virtual CD Server 8i will use: TCP/IP, AppleTalk or both.

6. Click on Finish.
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Managing CDs

To Archive a CD
For an explanation of "Archiving" see the section of this guide titled "Caching & Archiving"

1. Open the web browser and http: to the IP address (i.e. http://192.168.1.1)

2. Open the Discs & Drives page.

3. Select how to Archive

3.1. Discs and file System - individual disc gets archived

3.2. Drives - any disc in that bay gets archived

4. Remove disc when the archive is complete.

To Delete an Archived CD
1. Open the web browser and http:// to the IP address (i.e. http://192.168.1.1)

2. Open the Disc & Drives page.

3. Select the Discs and File System view

4. Remove the check from Archive box next to the disc that is to be deleted.

Assigning Rights

Disc and Files System
Rights under the Disc and File System view are assigned to volumes only. A volume is the data on a CD-
ROM. It is not the drive bay that holds/reads the CD-ROM.

General
The Name and Description of the volume, as it appears on the network, can be modified on this page. If, for
licensing purposes the number of user allowed access to the volume must be limited, the maximum number
of users may be entered here.

Web Security
Access rights to a volume may be inherited from the parent folder, or restricted by use of a password. By
default all CD volumes are available on the main page of the Virtual CD Server 8i. To prevent this modify
the HTTP network configuration

Windows Security
To Assign User Level Access Rights
1. Open the Discs & Drives page.

2. Select the Disc and File System view.

2.1. To shield all volumes highlight the Volumes folder.

2.2. To shield a particular volume highlight that volume in the file tree.

3. Click on Access Rights.
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4. Select the Windows Security tab.

4.1. Add permissions for any users and groups.

5. Click OK.

To Assign Share Level Access Rights
1. Open the Discs & Drives page.

2. Select the Discs and File System view.

2.1. To shield all volumes highlight the Volumes folder.

2.2. To shield a particular volume highlight that volume in the file tree.

3. Click on Access Rights.

4. Select the Windows Security tab.

4.1. Enter the share name and access type (Read Only or Full) for the share.

5. Click OK.

Unix Security
1. Open the Disc & Drives page.

2. Select the Disc and File System view.

2.1. To shield all volumes highlight the Volumes folder.

2.2. To shield a particular volume highlight that volume in the file tree.

3. Click on Access Rights.

4. Select the UNIX Security tab.

5. Enter any description of the volume, as it appears on the network.

6. Use the radio buttons to select adding a Host Name or IP Address.

6.1. Place the information in the appropriate box.

7. Click on the Add button.

8. Click on OK.

Mac Sharing
1. Open the Disc & Drives page.

2. Select the Disc and File System view.

2.1. To shield all volumes highlight the Volumes folder.

2.2. To shield a particular volume highlight that volume in the file tree.

3. Click on Access Rights.

4. Select the Mac Sharing tab.

5. Use the radio buttons to elect to share the volume.

5.1. Enter the network share name.

6. Use the radio buttons to select the password options for the volume.

7. Click on OK.



PAGE 14 VIRTUAL CD SERVER  8I ADMINISTRATION GUIDE

Call 800-38-Logic for help

Drives
Rights under the Drives view are assigned to devices or the disc inserted into the device. When access rights
are assigned to a drive, any CD-ROMs inserted into the drive bay inherit those rights. In addition, the CD-
ROM will be shared on the network using the drive bay name, not the volume name of the CD-ROM.

Rights to volumes (CD-ROMs) can also be assigned using the Drives view. A radio button at the top of the
Access Rights page permits the Disc (volume) or the Drive to be selected. The information below relates
only to the Drive options.

General
The Name and Description of the Drive, as it appears on the network, can be modified on this page. If the
number of user allowed access to the Drive must be limited due to licensing purposes, the maximum number
of users may be entered here.

Web Security
Access rights to a Drive may be inherited from the parent folder, or restricted by use of a password. By
default all Drives (with CD-ROMS inserted) are available on the main page of the Virtual CD Server 8i. To
prevent this modify the HTTP network configuration

Windows Security
To Assign User Level Access Rights
1. Open the Discs & Drives page.

2. Select the Drives view

3. Select the Drive to be secured.

4. Click on Access Rights.

5. Open the Windows Security page.

5.1. Add permissions for the users and groups you want to grant access.

6. Click OK.

To Assign Share Level Access Rights
1. Open the Discs & Drives page.

2. Select the Drives view

3. Select the Drive to be secured.

4. Click on Access Rights.

5. Open the Windows Security page.

5.1. Enter the share name and access type (Read Only or Full) for the share.

6. Click OK.
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Unix Security
1. Open the Disc & Drives page.

2. Select the Drives view.

3. Select the Drive to be secured.

4. Click on Access Rights.

5. Select the UNIX Security tab.

6. Enter any description of the volume, as it appears on the network.

7. Use the radio buttons to select adding a Host Name or IP Address.

7.1. Place the information in the appropriate box.

8. Click on the Add button.

9. Click on OK.

Mac Sharing
1. Open the Disc & Drives page.

2. Select the Drives view.

3. Select the Drive to be secured.

4. Click on Access Rights.

5. Select the Mac Sharing tab.

6. Use the radio buttons to elect to share the volume.

6.1. Enter the network share name.

7. Use the radio buttons to select the password options for the volume.

8. Click on OK.
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User Access

Windows Users
Most Windows applications require that a static drive mapping be used to access network resources. To mak
a drive letter:

1. Open Network Neighborhood.

2. Browse to locate the Virtual CD Server 8i. Double-click on the server icon.

3. To provide global access to all CD-ROMS

3.1. Right-click on the Volumes volume.

3.2. Select Map Network Drive from the pop-up menu.

3.2.1. Place a check in the Reconnect at Logon box if desired.

4. Click on OK.

Mac Users
The Chooser is used to mount/access Imaged CDs.

1. Click on the Apple menu.

2. Select Chooser.
3. If AppleTalk is not currently active, click on the radio button to make it active.

4. Connect to the server.

4.1. Select AppleShare. All Mac servers will appear in the right window.

4.1.1. Highlight the Virtual CD Server 8i. Click on OK
4.2. Select the Volume to mount. Click on OK

4.2.1. By selecting the Volumes volume, all Imaged CDs will be accessible.

4.3. A connection log in window will open.

4.3.1. If no Macintosh security has been enabled, the default password is pass.

5. Select the Imaged CD(s) you want to mount and click on OK.
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Unix Users
The Virtual CD Server 8i appears as any other server in the network. Normal commands are used to access
the unit.

1. Create a directory for the Virtual CD Server 8i. Mkdir <directory>

2. Mount the Virtual CD Server 8i mount <hostname>:/ <directory>

3. Change into the directory to access the CD-ROMs.

If the Virtual CD Server 8i is at an IP addres of 192.168.1.100 and the Volumes directory is being mounted
the commands would be:
mkdir /volumes
mount 192.168.1.100:/ /volumes
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Technical Support

To Restore System Defaults
If the system password is forgotten, or a necessary network protocol is disabled and cannot be restored, the
reset button can be used to restore the out-of-the-box system defaults. This button is located on the rear
panel of the unit, near the Ethernet connector.

1. Turn off the Virtual CD Server 8i.

2. Press in and hold the Push button while turning on the unit.

3. Hold the Push button until the Network indicator flashes at regular two-second intervals.

4. Release the Push button and wait at least two seconds (one flash of the Network indicator).

5. Press in and hold the Push button for at least five seconds until the Network indicator remains
constantly lit.

6. To restart the Virtual CD Server 8i, turn off the power, wait twenty seconds and then turn it back on
again. It is now reset to the factory defaults.

Support Numbers
Academy Computer Services:

800–385–6442, Fax: 781-279-4262

Academy email:
primary@academycomputerservice.com

Web address:
www.LegalHardware.com
www.SchoolHardare.com
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Warranty and Disclaimer Information
Specifications subject to change without notice. All trademarks the property of their respective companies.
Warranty: One year parts and labor from date of purchase. This warranty is in lieu of all other express
warranties which now or hereafter might otherwise arise with respect to this product, implied warranties,
including those of merchantability, fitness for a particular purpose and non–infringement shall (A) have no
greater duration that 1 year from the date of purchase (B) terminate automatically at the expiration of such
period and (C) to the extent permitted by law be excluded. In the event this product becomes defective
during the warranty period, the purchaser’s exclusive remedy shall be repair. Incidental or consequential
damages, including without limitation loss of data or inaccurate retrieval of data, arising from breach of any
express or implied warranty are not the responsibility of Academy Computer Services, Inc. and, to the extent
permitted by law, are hereby excluded both for property damage, and to the extent not unconscionable, for
personal injury damage.

Options
Many installations require modifications or additions for optimal functionality. To this purpose we offer CD
changers/jukeboxes, Macintosh interfaces, OS/2 drivers, Ornetix Software for CD management in Novell or
Windows NT environments, dual channel SCSI cards for multiple towers, multiplexers, Virtual CD Towers
using hard disks and other options too numerous to list. We have extensive experience with large and custom
installations. Please call 800-385-6442 for a tailored quotation.

Recommendations for Further Study
Elshami, Ahmed M. Networking CD-ROMs. American Library Association. Chicago. IL. 1996. 800-545-
2433 press 7 to order.

Ridge, Peter M. The Book of SCSI, A Guide for Adventurers. No Starch Press. Daly City. CA. 1995. 800-788-
3123 to order.
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